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1. はじめに 

本書は、「リモート I/O変換器 R7xxxシリーズ コンフィギュレータソフトウェア」の取り扱い方法、操作

手順、注意事項などを説明したものです。 

Windows の操作や用語を理解している方を前提にしています。Windowsの操作や用語については、それぞ

れのマニュアルを参照してください。 

 

1.1. R7CFGとは 

リモート I/O 変換器 R7xxx シリーズは、ネットワーク通信機能付の変換器ユニットであり、

MECHATROLINK-IIIをはじめとする各種オープンフィールドネットワーク対応のリモート I/O変換器です。 

R7CFG は、このリモート I/O 変換器のスケーリング、ゼロ・スパン設定など各種パラメータを設定し、ユ

ーザの要求に合致したシステムを構築するためのツールです。 

コンフィギュレータ接続ケーブル(形式：MCN-CON、COP-US、または市販の USB ケーブル)を用いるこ

とにより、Windows対応パソコンに接続することができます。 

 

1.2. R7CFGの主な機能 

R7CFGには以下のような機能があります。 

① レンジ設定機能、センサタイプ設定機能 

・チャネル毎にレンジの設定、センサタイプの設定ができます。 

・温度入力ユニットでは、チャネル毎に 0%/100%の温度の設定ができます。 

② スケーリング設定機能、バイアス設定機能、ゲイン設定機能 

・チャネル毎にスケーリング設定、バイアス設定、ゲイン設定ができます。 

③ ファイル管理機能 

・上記①②で行った設定内容をパソコン上のファイルに保存することができます。従って、コンフィギュ

レーション作業は、R7CFGをリモート I/O変換器と接続しないオフライン状態で編集できます。 

・保存したファイルから設定内容を読み出し、リモート I/O変換器に設定することができます。 従って、

複数のユニットに対し、誤りなくコンフィギュレーション作業が可能になります。 

④ モニタリング機能 

・コンフィギュレーションしたデータを用いて、現在の入出力データのチェックが行えます。 
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1.3. 動作環境 

R7CFGをお使いいただくためには，以下の環境が必要です。 

PC IBM PC 互換機 

OS Windows 10 (32bit,64bit)、Windows 11 

 (注)全ての環境での動作を保証するものではありません。 

CPU Microsoft 社が規定する OS の動作保証をしている性能以上 

メモリ Microsoft 社が規定する OS の動作保証をしている性能以上 

通信ポート 機器と接続する COM ポート（COM1～COM16） 

 

機器と PCの通信ポートを接続するために、以下のコンフィギュレータ接続ケーブルが必要です。 

R7I4DECT、R7I4DML3、R7G4HEIP、R7I4DCIE、R7I4DEIP、R7G4JECT以外の場合… 

 形式：MCN－CONまたは COP－US 

R7I4DECT、R7I4DML3、R7G4HEIP、R7I4DCIE、R7I4DEIP、R7G4JECTの場合… 

 市販のUSBケーブル（TypeA－MiniB）をご使用ください。 
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1.4. 対応する形式 

本書で説明する R7CFGに対応する形式は以下となります。 

R7G4HML3-6-SV4 R7G4HML-6-SVF8N R7F4HEIP-DA32 

R7G4HML3-6-SVF4 R7G4HH-A-YVF4 R7F4HEIP-DC32 

R7G4HML3-6-TS4 R7G4HH-A-SVF4 R7F4DD-DA16 

R7G4HML3-6-PA1A R7K4DM-CT32 R7F4DD-DC16 

R7G4HML3-6-PA1A/A R7K4FE-6-DC16 R7F4DD-DAC16 

R7G4HML3-6-PA1J R7I4DECT-1-DA32A R7F4HD-DA32 

R7G4HML3-6-PA1J/A R7I4DECT-1-DC32A R7F4HD-DC32 

R7G4FML3-6-DA16 R7I4DECT-1-DAC32C R7F4HD-DAC32 

R7G4FML3-6-DC16 R7I4DECT-1-YVF4 R7I4DML3-DA32 

R7G4FML3-B-DA16 R7I4DECT-1-SVF8N R7I4DML3-DC32 

R7G4HML3-6-LC2 R7I4DECT-1-SVSF8N R7I4DML3-DAC32 

R7G4HML3-6-LC2A R7I4DECT-1-PA8A R7I4DCIE-LC2 

R7G4HML3-6-YVF4 R7G4HEIP-6-DA16 R7I4DEIP-DAC32 

R7G4HML3-6-YSF4 R7G4HEIP-6-DC16 R7G4FM-DA16 

R7G4HML3-6-STYVS1 R7F4HEIP-DA16 R7K4FM-DA32 

R7G4HML-6-YVF4 R7F4HEIP-DC16 R7G4JECT-LC2 

R7G4HML-6-SVF4 R7F4HEIP-DAC16 R7G4HML3-6-SVAF4 

 

※次の形式は設定する項目がないため、未対応です。 

R7K4FML3-6-DA32、R7K4FML3-6-DC32、R7K4FML3-6-DAC32、R7F4HML3-D-DAC32、 

R7K4JML3-E-DAFC64 
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2. R7CFGを使うための準備 

コンフィギュレータソフトウェアを使うためには、ソフトウェアをインストールする必要があります。コ

ンフィギュレーションしたデータを制御モジュールに書きこむためには、パソコンとリモート I/O変換器が

正しく接続されていなければなりません。 

ここでは、ソフトウェアのインストール方法、アンインストール方法、接続方法について説明します。 

 

2.1. R7CFGのインストール 

① Windowsを起動します。 

② 弊社Webサイトより、コンフィギュレータソフトウェアのダウンロードを行いお使いのパソコンのロー

カルディスクに保存してください。 

③ ダウンロードしたファイルのサイズ、バージョンを確認してください。 

ファイル名： R7CFG_R□.zip □にはバージョンが入ります。 

④ R7CFG_R□.zipを解凍します。 

⑤ R7CFGフォルダの中の setup.exeを実行し、インストーラの指示に従いインストールを行ってください。 

 

これでインストールは終了です。 

 

【注意】 

プログラムを再インストールする場合 

２.２.で説明する R7CFGのアンインストールを行ってからインストールしてください。 

 

2.1.1. ドライバソフトのインストール 

 

  R7CFG と R7xxx シリーズ を USB 接続する場合には R7CFG をインストールした PC にドライバ

ソフトが必要です。 R7xxx シリーズには FTDI 社のチップが使用されており、専用のドライバソフトを 

PC にインストールすることで PC に新しいシリアルポートが増設されます。増設されたシリアルポートを 

COMポートとして選択してください。  

 

・インターネットを使用できる環境にある PC の場合、R7xxx シリーズ と接続した際に Windows 

Updateでドライバソフトがインストールされます。  

  

・弊社のホームページからも R7CFG 用ドライバソフトをダウンロードすることができます。  
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2.2. R7CFGのアンインストール 

2.2.1. Windows10、11の場合 

① Windowsのスタートボタンをクリックして［設定］→[アプリ]をクリックします。 

→アプリと機能が表示されます。 

② 表示されているアプリケーションの一覧から［R7CFG］を選択します。 

③ [アンインストール]ボタンをクリックします。 

④ [ファイル削除の確認]ダイアログが表示されるので，[はい]ボタンをクリックします。 

→R7CFGに関連するファイルが削除されます。 

 

 

2.3. パソコンと R7本体の接続 

① コンフィギュレータ接続ケーブルをパソコンに接続します。 

→本コンフィギュレータソフトウェアは COM1～COM16のいずれかの COMポートを使用します。 

 

【注意】 

パソコンに実装されていない COM ポートを選択した場合、R7CFG が強制終了することがあります。

必要な場合は、パソコンの COMポートの設定を変更してください。 

 

② コンフィギュレータ接続ケーブルを R7本体の設定用コネクタに接続します。 
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2.4. R7CFGの起動と終了 

（本章で示す画面はイメージを示すものです。バージョンアップにより細部が変更されることがありま

す） 

 

2.4.1. R7CFGの起動 

[スタート]－[プログラム]－[R7CFG]を選択します。R7CFGが起動されると次のような画面が表示されま

す。（図 2-1 R7CFG起動画面） 

 

図 2-1．R7CFG起動画面 

2.4.2. R7CFGの終了 

R7CFGウィンドウのメニューバーの左にある[File]-[Exit]ボタンをクリックすると終了します。 
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3. R7CFG画面詳細 

R7CFGの画面構成と詳細機能について説明します。（図 3-1詳細図） 

R7CFGは、 

① 画面上部のメニューバー 

② 製品構成情報 

③ 通信情報 

④ 画面左側の各種ボタン 

⑤ モニタウィンドウ 

⑥ コンフィギュウィンドウ 

にて構成されています。 

 

図 3-1．詳細図 

 

  

 
 

 

①  

②  ③  

④  

⑤  

⑥  
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3.1. 画面上部のメニューバー 

 

 

図 3-2．メニューバー[File] 

 

3.1.1. コンフィギュレーションデータの保存 

R7CFGはコンフィギュデータをパソコンに保存することが可能です。 

① [Upload]ボタンをクリックし、現在のコンフィギュレーションデータを R7CFGへ読み出します。 

② コンフィギュレーションデータを変更した場合には、変更後[Download]ボタンをクリックします。 

③ メニューバーの“File”→“Save”をクリックします。 

④ 保存場所、ファイル名を設定し保存します。 

 

3.1.2. 保存したコンフィギュレーションデータの読み出し 

保存していたコンフィギュレーションデータをパソコンから読み出し、ユニットに書き込むことが可能で

す。 

① メニューバーの“File”→“Open”をクリックします。 

② 保存場所、ファイル名を選び R7CFGに読み出します。 

③ [Download]ボタンをクリックし、コンフィギュレーションデータをユニットへ書き込みます。 

④ 保存していたコンフィギュレーションデータに変更がある場合には、変更後[Download]ボタンを

クリックします。 

 

3.1.3. R7CFGの終了 

R7CFGを終了するには、メニューバーから“File”→“Exit”をクリックします。 

 

3.1.4. オフラインでの設定ファイル操作 

ユニットにコンフィギュレータ接続ケーブルを接続していない状態からでも、設定ファイルを生成するこ

とが可能です。 

① メニューバーの“Model Select”→「任意の基本ユニットの形式」をクリックします。 

② 必要に応じてコンフィギュレーションデータを変更します。 

③ メニューバーの“File”→“Save”をクリックします。 

④ 保存場所、ファイル名を設定し保存します。 



R7CFGバージョン 0.01.59取扱説明書 

NM-7769 改 27 13/65 MG CO., LTD.
www.mgco.jp

 

 

図 3-3．メニューバー[Model Select] 

 

※R7G4FML3-B-DA16は、R7G4FML3-6-DA16と同等品となります。 

 そのため R7G4FML3-6-DA16の設定ファイルを R7G4FML3-B-DA16にダウンロードできます。 

 

3.1.5. R7CFGのバージョン表示 

R7CFGのバージョンを確認するには、メニューバーから“Help”→“Version”をクリックします。 

 

 

図 3-4．メニューバー[Help] 
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3.2. 製品構成情報 

図 3-5に製品構成情報を示します。 

 

図 3-5．製品構成情報 

 

3.2.1. 基本ユニット名表示、バージョン表示 

基本ユニットの形式及びバージョンを表示します。 
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3.3. 通信情報 

 図 3-6に通信情報を示します。 

 

図 3-6．通信情報 

 

3.3.1. COMポート名表示 

 現在接続している COMポート名を表示します。 

 

3.3.2. 通信状態表示 

 現在の接続状態を表示します。 

 Connected：COMポートと接続している状態です。 

 Disconnected：COMポートと接続していない状態です。 
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3.4. 画面左側の各種ボタン  

 図 3-7に各種ボタンを示します。 

 

図 3-7．各種ボタン 

 

・Startボタン・・・モニタリングを開始します。 

・Stopボタン・・・モニタリングを停止します。 

・Connectボタン・・・COMポートに接続し、R7本体と通信可能な状態にします。 

・Disconnectボタン・・・COMポートを切断し、R7本体と通信不可能な状態にします。 

・Settingボタン・・・COMポートの設定をします。 

・Uploadボタン・・・コンフィギュレーションデータを R7CFGにアップロードします。 

・Downloadボタン・・・コンフィギュレーションデータを R7本体にダウンロードします。 
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3.5. モニタウィンドウ 

 図 3-8、図 3-9にアナログタイプの基本ユニットのモニタウィンドウを、図 3-10に接点タイプの基本

ユニットのモニタウィンドウを示します。 

   アナログタイプは数値を表示しています（図 3-8）。 熱電対ユニットでは数値の右側にバーンアウ

ト状態を表示しています。 

 ・正常な状態：背景色は薄い黄色表示になります。 

 ・バーンアウト状態：背景色は赤色表示になります（図 3-9）。 

 

  接点タイプは接点の状態により、表示色が変わります。ONで緑色表示、OFFで赤色表示です。 

  

 

図 3-8．アナログタイプ１ 

 

図 3-9．アナログタイプ２ 

 

図 3-10．接点タイプ 
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3.6. コンフィギュウィンドウ 

 コンフィギュウィンドウに表示される設定項目は、基本ユニットにより異なります。 

 設定項目が多い場合には、チャネル指定のプルダウンメニュー、[Setting1]、[Setting2]ボタンが表示さ

れます。 

 メニュー選択またはボタンをクリックすることにより、画面を切り替えます。（図 3-11Settingボタン） 

  

図 3-11．Setting ボタン 

3.6.1. スケーリング設定 

 図 3-12にスケーリング設定画面を示します。 

 

図 3-12．スケーリング設定 

 スケーリングが可能な基本ユニットの場合に表示されます。整数の-32000～32000の範囲で設定してく

ださい。また、設定する数値は 0%側(Zero Scale) ＜ 100%側(Full Scale) となるように設定してくだ

さい。 

  設定後は[Download]ボタンをクリックしてください。 

 

3.6.2. バイアス設定、ゲイン設定 

 図 3-13にバイアス設定、ゲイン設定画面を示します。 

 

図 3-13．バイアス設定、ゲイン設定 

 バイアス設定、ゲイン設定が可能な基本ユニットの場合に表示されます。 

 バイアス設定は、-320.00～320.00の範囲で設定してください。 

 ゲイン設定は、-3.2000～3.2000の範囲で設定してください。 

  設定後は[Download]ボタンをクリックしてください。 
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3.6.3. 電圧、電流レンジ確認 

 図 3-14に電圧、電流レンジ確認画面を示します。 

 

図 3-14．電圧、電流レンジ確認 

 設定されている電圧もしくは電流レンジが表示されます。 

 

3.6.4. 温度レンジ設定 

 図 3-15に温度設定画面を示します。 

 

図 3-15．温度設定 

 温度レンジ設定が可能な基本ユニットの場合に表示されます。入力可能な範囲が表示されますので、そ

の範囲内で設定してください。また、設定する数値は 0%側(Zero temp) ＜ 100%側(Full temp) とな

るように設定してください。 

  設定後は[Download]ボタンをクリックしてください。 

 

熱電対ユニットは出荷時設定として“Zero temp”と“Full temp”がともに“0.00”に設定されています。

この場合、上位の PLCや PCには、実量値（温度データ）を送信しています。 

⇒温度単位が摂氏（℃）または絶対温度（Ｋ）の場合には、10倍した値（例えば、10.5℃ならば 105）を

送信します。また華氏（°Ｆ）の場合にはそのままの値を送信します。 

  

 上位 PLC や PC に、スケーリングデータを送信したい場合は、この温度レンジ設定およびスケーリン

グ設定を行ってください。 

 

“Zero temp”の温度が“Zero scale”に、“Full temp”の温度が“Full scale”にスケーリングされてスケーリン

グデータを送信します。 

バーンアウト時は、各熱電対の入力可能範囲の上限温度または下限温度に相当するスケーリング値を送信

しますが、スケーリング値の 115%を超える場合は 115%に、-15%を下回る場合は-15%に制限されます。 
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3.6.5. バーンアウト設定 

 図 3-16にバーンアウト設定画面を示します。 

 

図 3-16．バーンアウト設定 

 バーンアウト設定が可能な基本ユニットの場合に表示されます。 

 UP：上方バーンアウトの設定になっています。 

 DOWN：下方バーンアウトの設定になっています。 

  設定後は[Download]ボタンをクリックしてください。 

 

 

3.6.6. チャネル毎のレンジ設定 

 

 図 3-17にレンジ設定画面を示します。 

 

図 3-17．レンジ設定画面 

 レンジ設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.7. チャネル毎のセンサ設定 

 図 3-18にセンサ設定画面を示します。 
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図 3-18．センサ設定 

 センサ設定が可能な基本ユニットの場合に表示されます。  

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.8. チャネル毎の温度単位設定 

 図 3-19に温度単位設定画面を示します。 

 

図 3-19．温度単位設定 

 温度単位設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

  

3.6.9. チャネル毎のドロップアウトの設定 

 図 3-20にドロップアウト設定画面を示します。 

 

図 3-20．ドロップアウト設定 

 ドロップアウト設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.10. 移動平均回数の設定 

 図 3-21に移動平均回数設定画面を示します。 
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図 3-21．移動平均回数設定 

 移動平均回数設定が可能な基本ユニットの場合に表示されます。 

 設定値が移動平均の分母の数として動作します。  

 設定可能範囲は 1,2,4,8,16,32,64,128,256です。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.11. チャネル毎の入出力端子の有効／無効の設定 

 図 3-22に入出力端子の有効／無効設定画面を示します。 

 

 

図 3-22．入出力端子の有効／無効設定 

 入出力端子の有効／無効設定が可能な基本ユニットの場合に表示されます。 

 設定値が「Valid」で有効、「Invalid」で無効として動作を開始します。  

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.12. 通信断時出力設定 

 図 3-23に通信断時出力設定画面を示します。 

 

図 3-23．通信断時出力設定 

 通信断時出力設定が可能な基本ユニットの場合に表示されます。 

 設定値が「Hold」で通信断時は出力値を保持、「Clear」で通信断時は出力値をクリアします。  

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.13. チャネル毎の出力クリア値設定 

 図 3-24に出力クリア値設定画面を示します。 

 

図 3-24．出力クリア設定 

 出力クリア値設定が可能な基本ユニットの場合に表示されます。 
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 本設定値は、「通信断時により出力値をクリア」として設定される出力値となります。 

 設定値は、－15.00～115.00の範囲で設定してください。 

 設定後は[Download]ボタンをクリックしてください。 

 

 

3.6.14. 変換速度／変換精度設定 

 図 3-25に変換速度／変換精度設定画面を示します。 

 

図 3-25．変換速度設定 

 変換速度／変換精度設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.15. 計測データタイプ設定 

 図 3-26に計測データタイプ設定画面を示します。 

 

図 3-26．計測データタイプ設定 

 計測データタイプ設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.16. 速度データ計測時の速度入力レンジ設定 

 図 3-27に速度データ計測時の速度入力レンジ設定画面を示します。 

 

図 3-27．速度データ計測時の速度入力レンジ設定 

 速度データ計測時の速度入力レンジ設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.17. 位置データ計測時のカウントモード設定 

 図 3-28に位置データ計測時のカウントモード設定画面を示します。 

 

図 3-28．位置データ計測時のカウントモード設定 
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 位置データ計測時のカウントモード設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.18. 位置データタイプ設定 

 図 3-29に位置データタイプ設定画面を示します。 

 

図 3-29．位置データタイプ設定 

 位置データタイプ設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

 

3.6.19. 平均化処理設定 

 図 3-30に平均化処理設定画面を示します。 

 

図 3-30．平均化処理設定 

 平均化処理設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

 

3.6.20. 取込周期設定 

 図 3-31に取込周期設定画面を示します。 

 

図 3-31．取込周期設定 

 取込周期設定が可能な基本ユニットの場合に表示されます。 

 設定後は[Download]ボタンをクリックしてください。 

 

 

3.6.21. 接点出力無効設定 

 図 3-32に接点出力無効設定画面を示します。 
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図 3-32．接点出力無効設定 

 接点出力無効設定が可能な基本ユニットの場合に表示されます。 

 設定値によりチェック無で接点出力有効、チェック有で接点出力無効として、該当端子が動作します。 

 設定後は[Download]ボタンをクリックしてください。 

 

3.6.22. データタイプ設定 

 図 3-33にデータタイプ設定を示します。 

 

図 3-33．データタイプ設定 

 データタイプ設定が可能な基本ユニットの場合に表示されます。 

 「Unsigned」設定時、スケーリング設定の設定範囲が 0～65535になります。 

 「Signed」設定時、スケーリング設定の設定範囲が-32768～32767になります。 

 設定後は[Download]ボタンをクリックしてください。 
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4. R7CFGの使い方 

 この章は、お客様がご購入後、すぐに「モニタリング」や「コンフィギュレーション」を行いたい場合

に、お読みください。各節に例を挙げて説明していますので、手順に従い操作いただくことにより、「モニ

タリング」、「コンフィギュレーション」が行えます。 

 R7CFGの画面詳細（各種ボタンの機能）、設定項目の詳細については３章をご参照ください。 

 

4.1. モニタリングするには？ 

 R7G4HML3-6-SV4をモニタリングする手順を説明します。（他の機種でも同様です。） 

 以下の手順に従い操作してください。 

① パソコンと R7G4HML3-6-SV4を接続し、R7G4HML3-6-SV4の電源を投入します。 

（接続方法は「2.3.パソコンと R7本体の接続」をご参照ください。） 

② R7CFGを起動し、[Setting]ボタンをクリックします。 

→COMポートの選択画面が表示されます。 

③ 使用する COMポートを選択し、OKボタンをクリックします。 

→正しく接続され、パソコンと通信状態になると、画面右上の通信マークが緑色になります。 

また、自動的にユニットの情報を R7CFGにアップロードします。（図 4-1初期画面） 

→接続に失敗した場合、エラーが表示されます。（図 4-2接続エラー） 

 ⇒パソコンの COMポートの設定をご確認ください。 

→アップロードに失敗した場合、エラーが表示されます。（図 4-3アップロードエラー） 

 ⇒パソコンと R7本体との接続状態、R7本体の電源をご確認ください。 
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図 4-1．初期画面 

 

図 4-2．接続エラー 

 

 

図 4-3．アップロードエラー 

 

④ 正常に接続できましたら、[Start]ボタンをクリックします。 

モニタリングが開始され、画面右上の通信マークが黄色になります。（図 4-4モニタリング） 
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図 4-4．モニタリング画面 

 

⑤ モニタリングを終了する場合は、[Stop]ボタンもしくは、[Disconnect]ボタンをクリックします。 
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4.2. コンフィギュレーションするには？ 

R7G4HML3-6-SV4、R7G4HML3-6-TS4を対象として、コンフィギュレーションを行います。 

 

まず、R7G4HML3-6-SV4 を用いて「4.1 モニタリングするには？」の手順①～③を行い、初期画面を表

示します。 

（初期画面では、CH0～CH3まですべて-10～+10V のレンジで、入力 0V(50%)の状態です。） 

 

4.2.1. 例１：「R7G4HML3-6-SV4の CH0のスケーリングを-20000～+20000に変更する。」 

   図 4-5に設定画面を示します。図中の枠内が CH0に関するパラメータとなります。 

① 枠中の[Zero Scale]に-20000、[Full Scale]に 20000を書き込みます。 

② [Download]ボタンをクリックします。 

⇒ダウンロード後に自動的に最新の設定値に更新します。（R7本体から R7CFGへ設定値がアップロー

ドされます。）正常にダウンロードが完了したことをご確認ください。 

    ⇒スケーリングを変更したことにより、CH0の値が 0になりました。 

 

図 4-5．設定画面（例１） 
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4.2.2. 例２：「R7G4HML3-6-SV4の CH1のバイアスを変更する。」 

   図 4-6に設定画面を示します。図中の枠内が CH1に関するパラメータとなります。 

   （入力レンジ：-10～+10V、スケーリング：0～10000） 

① 入力レンジ-10～+10V の 0%（-10V）を入力し、モニタリングします。（モニタリング

の詳細については、「4.1モニタリングするには？」をご参照ください。） 

CH1の値が 100であった場合、100/10000*100=1.00[%]の誤差が算出されます。 

② 枠内の[Bias]に-1.00を書き込みます。 

③ [Download]ボタンをクリックします。 

⇒ダウンロード後に自動的に最新の設定に更新します。（R7本体から R7CFGへ設定値がアップロード

されます。）正常にダウンロードが完了したことをご確認ください。 

⇒バイアスを変更したことにより、CH1の値が 0になりました。 

 

図 4-6．設定画面（例２） 
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4.2.3. 例３：「R7G4HML3-6-SV4の CH1のゲインを変更する。」 

   図 4-7に設定画面を示します。図中の枠内が CH1に関するパラメータとなります。 

   （入力レンジ：-10～+10V、スケーリング：0～10000） 

 

① 入力レンジ-10～+10Vの 100%（10V）を入力し、モニタリングします。（モニタリングの詳細に

ついては、「4.1モニタリングするには？」をご参照ください。） 

CH1の値が 10100であった場合、10100/10000=0.9901のゲインが算出されます。 

② 枠内の[Gain]に 0.9901を書き込みます。 

③  [Download]ボタンをクリックします。 

   ⇒ダウンロード後に自動的に最新の設定に更新します。（R7 本体から R7CFG へ設定値がアップロー

ドされます。）正常にダウンロードが完了したことをご確認ください。 

   ⇒ゲインを変更したことにより、CH1の値が 10000になりました。 

 

図 4-7．設定画面（例３） 
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4.2.4. 例４：「R7G4HML3-6-SV4の CH3のみ 入力レンジを 0～20mAに変更する。」 

① [Setting2]のボタンをクリックします。 

⇒レンジ変更画面が表示されます。（図 4-8レンジ変更画面）(設定項目が複数ある機種では、[Setting1]、

[Setting2]のボタンが表示されます。) 

② ドロップダウンメニューから[0mA to 20mA]を選択します。（図 4-9 ドロップダウン画

面） 

③ [Download]ボタンをクリックします。 

⇒ダウンロード後に自動的に最新の設定値に更新します。 （R7本体から R7CFGへ設定値がアップロー

ドされます。） [Setting2]ボタンをクリックし、正常にダウンロードが完了したことをご確認ください。 

④ [Disconnect]ボタンをクリックし、COMポートを閉じます。 

⑤ ユニット本体の電源を切ります。 

⑥ ユニット本体の電源を入れ、再び初期画面にしてください。 

⇒正しく設定が行われた状態を図 4-10に示します。（図 4-10レンジ変更後の画面） 

⇒CH3のレンジが 0～20mAに変更できたことをご確認ください。 

 

図 4-8．レンジ変更画面(例４)
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図 4-9．ドロップダウン画面（例４） 

 

 

図 4-10．レンジ変更後の画面（例４） 
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4.2.5. 例５：「R7G4HML3-6-TS4の CH0のみ T熱電対に変更する。」 

 

次に、R7G4HML3-6-TS4を対象にコンフィギュレーションを行います。 

まず、R7G4HML3-6-TS4 を用いて「4.1 モニタリングするには？」の手順①～③を行い、初期画面を表

示します。 

（図 4-11 R7G4HML3-6-TS4 の初期画面、CH0～CH3 すべて K 熱電対で、入力はオープン（バーンア

ウト状態）です。） 

 

図 4-11．R7G4HML3-6-TS4の初期画面 
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① [Setting2]のボタンをクリックします。 

⇒熱電対・温度単位変更画面が表示されます。（図 4-12 R7G4HML3-6-TS4の変更画面） 

② ドロップダウンメニューからＴ熱電対を選択します。（図 4-13ドロップダウン画面） 

③ [Download]ボタンをクリックします。 

⇒ダウンロード後に自動的に最新の設定値に更新します。（R7本体から R7CFGへ設定値がアップロード

されます。） [Setting2]ボタンをクリックし、正常にダウンロードが完了したことをご確認ください。 

④ [Disconnect]ボタンをクリックし、通信を終了させてください。 

⑤ ユニット本体の電源を切ります。 

⑥ ユニット本体の電源を入れ、再び初期画面にしてください。 

⇒正しく設定が行われた状態を図 4-14に示します。（図 4-14熱電対変更後の画面） 

⇒CH0の熱電対が T熱電対に変更できたことをご確認ください。 

 

図 4-12．R7G4HML3-6-TS4の変更画面(例５) 
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図 4-13．ドロップダウン画面（例５） 

 

 

図 4-14．熱電対変更後の画面（例５） 
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4.2.6. 例６：「R7G4HML3-6-TS4の CH1のみ 温度単位を F（華氏）に変更する。」 

① [Setting2]のボタンをクリックします。 

⇒熱電対・温度単位変更画面が表示されます。（参照：図 4-12 R7G4HML3-6-TS4の変更画面） 

② ドロップダウンメニューから「F」を選択します。 

③ [Download]ボタンをクリックします。 

⇒ダウンロード後に自動的に最新の設定値に更新します。（R7本体から R7CFGへ設定値がアップロード

されます。）正常にダウンロードが完了したことをご確認ください。 

⇒正しく設定が行われた状態を図 4-15に示します。（図 4-15温度単位変更後の画面） 

⇒温度単位を変更したことにより、CH1の値が 2682になりました。 

      

 

図 4-15．温度単位変更後の画面(例６) 
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4.3. R7G4HML3-6-PA1 の設定項目 

 R7G4HML3-6-PA1の設定項目について説明します。 

ファームウエア Version1.11以降の場合は、形式を R7G4HML3-6-PA1□/Aと表示します。 

「4.1.モニタリングするには？」の手順①～③を行い、初期画面を表示します。 

 

次に位置変換データ選択時の初期画面を示します。 

 

図 4-16．R7G4HML3-6-PA1の初期画面 1（位置変換データ） 

「DISPLAY SPEED(POSITION) DATA」のボタンで速度変換データまたは位置変換データの設定内容表

示に切り替えることができます。 

Current Pos 現在値 現在の積算値 

Latch Pos ラッチデータ ラッチ発生時の値 

Reset Pos リセットデータ リセット発生時の値 

Reset Value リセットバリュー リセット発生時または電源投入時に設定する初期値

（Min to Max） 

Liner Min 最小値 下限積算値(-2,100,000,000 to 2,099,999,999) 

Liner Max 最大値 上限積算値(-2,099,999,999 to 2,100,000,000) 

（注）最小値または最大値の設定を変更した場合、現在値とリセットバリューを初期値に戻すために、図 
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4-20．ラッチ・リセット設定画面のリセットとリセットデータクリアを実行してください。 

 

次に速度変換データ選択時の初期画面を示します。 

 

図 4-17．R7G4HML3-6-PA1の初期画面 1（速度変換データ） 

 

Current Speed 現在値 現在のスケーリング値 

Drop Out ドロップアウト(%) 入力周波数を 0 にするドロップアウト値を設定

(0.10 to 50.00) 

Bias バイアス バイアスを％で設定(-320.00 to 320.00) 

Gain ゲイン 倍率を設定(-3.2000 to 3.2000) 

Zero Scale ゼロスケーリング 0%スケーリング値(-32000 to 32000) 

Full Scale フルスケーリング 100%スケーリング値(-32000 to 32000) 
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図 4-18b．R7G4HML3-6-PA1の初期画面 2 

 

Data Type データタイプ 位置変換データ 

速度変換データ 

Position Count Mode カウント方法 Mode0：1 逓倍（A、B 相） 

Mode1：1 逓倍（A 相） 

Mode2：2 逓倍 

Mode3：4 逓倍 

Position Data Type カウンタ形式 リニアカウンタ 

リングカウンタ 

Speed Freq.Range 周波数レンジ 0～100 kHz 

0～10 kHz 

0～1 kHz 

0～100 Hz 

0～10 Hz 

0～1 Hz 

0～0.1 Hz 
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次に警報出力設定画面を示します。  

 

図 4-19．警報出力設定画面 

MECHATROLINK-III 

Command* 

MECHATROLINK-

III 

コマンド 

MECHATROLINK-III からの警報出力コマンド

を設定 

０：無効 / １：有効 

Alarm Type* 警報タイプ 警報出力タイプを設定 

０：警報無効 

１：速度データ上限 / ２：速度データ下限 

３：位置データ上限 / ４：位置データ下限 
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Position Setpoint/ 

Speed Setpoint 

警報設定値 警報設定値を設定 

上限警報の場合、警報設定値を超えると警報 ON、

下限警報の場合、警報設定値未満になると警報

ONします。 

・Position Setpoint 

LINER 上限設定値 Min to [Max－1] 

 下限設定値 [Min+1] to Max 

RING 上限設定値 0 to 4,294,967,294 

 下限設定値 1 to 4,294,967,295 

・Speed Setpoint：-15.00 to 115.00 % 

Position Hys/ 

Speed Hys 

ヒステリシス 警報設定値のヒステリシスを設定 

上限警報の場合、[警報設定値－ヒステリシス]未

満になると警報 OFF、下限警報の場合、[警報設

定値＋ヒステリシス]を超えると警報 OFF しま

す。 

・Position Hys 

LINER [Max－Min]未満 

 [上限警報設定値－ヒステリシス] > Min 

 [下限警報設定値+ヒステリシス] < Max 

RING 0 to 4,294,967,295 

 [上限警報設定値－ヒステリシス] > 0 

 [下限警報設定値+ヒステリシス] 

< 4,294,967,295 

・Speed Hys：0.00 to 115.00 % 

ALM:Power On Delay 警報パワーON ディ

レー 

警報パワーONディレーを設定 

電源投入時、設定時間内は警報出力なし 

ALM:On Delay Timer 警報 ON ディレータ

イマ 

警報 ONディレータイマを設定 

警報 ON時、設定時間内は警報出力なし 

ALM:On Hold Timer 警報ホールドタイマ 警報ホールドタイマを設定 

警報 ON時、少なくとも設定時間は ONを保持 

*MECHATROLINK-III コマンドと警報タイプは、独立して設定されます。MECHATROLINK-III コマ

ンドのみで動作させる場合は、警報タイプを 0：警報無効に設定してください。
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次にラッチ・リセット設定を示します。 

 

図 4-20．ラッチ・リセット設定画面 

 

External Latch 外部ラッチ設定 外部接点入力からのラッチを設定 

０ ： 無 効  /  １ ： 有 効  /  ２ ：

MECHATROLINK-III コマンドからの指

示 

MECHATROLINK- 

III Latch 

MECHATROLINK-III

ラッチ設定 

MECHATROLINK-III コマンドからのラ

ッチを設定 

０：無効 / １：有効 

MECHATROLINK- 

III Latch Data Clear 

MECHATROLINK-III

ラッチデータクリア設

定 

MECHATROLINK-III コマンドからのラ

ッチデータクリアを設定 

０：無効 / １：有効 

Latch ラッチ Request ボタンをクリックでラッチのリク

エストを発行 

Latch Data Clear ラッチデータクリア Request ボタンをクリックでラッチデータ

クリアのリクエストを発行 
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External Reset 外部リセット設定 外部接点入力からのリセットを設定 

０：無効 / １：有効 

MECHATROLINK- 

III Reset 

MECHATROLINK-III

リセット設定 

MECHATROLINK-III コマンドからのリ

セットを設定 

０：無効 / １：有効 

MECHATROLINK- 

III Reset Data Clear 

MECHATROLINK-III

リセットデータクリア

設定 

MECHATROLINK-III コマンドからのリ

セットデータクリア設定 

０：無効 / １：有効 

Z Reset Z相リセット 外部 Z相入力からのリセットを設定 

０：無効 / １：有効 

Z Reset / Z Latch Z 相リセット／Z 相ラ

ッチ※ 

外部 Z 相入力からのリセットまたはラッチ

を設定 

０：無効 / １：リセット / 2：ラッチ

※ 

Reset リセット Request ボタンをクリックでリセットのリ

クエストを発行 

Reset Data Clear リセットデータクリア Request ボタンをクリックでリセットデー

タクリアのリクエストを発行 

【注意】 

速度変換データ選択時は Resetのリクエストは無効です。 

 

※R7G4HML3-6-PA1のファームウエア Version1.11以降より選択可能です。 
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4.4. R7G4HML3-6-LC2,LC2A、R7I4DCIE-LC2、R7G4JECT-LC2の設定項目 

 R7G4HML3-6-LC2,LC2A、R7I4DCIE-LC2、R7G4JECT-LC2の設定項目について説明します。 

「4.1.モニタリングするには？」の手順①～③を行い、初期画面を表示します。 

 

次に初期画面を示します。 

 

図 4-21．R7G4HML3-6-LC2,LC2A、R7I4DCIE-LC2、R7G4JECT-LC2のスケール設定画面 

 

「Setting1」のボタンで設定内容表示に切り替えることができます。 

Zero Scale ゼロスケーリング 0%スケーリング値(-32000 to 32000) 

Full Scale フルスケーリング 100%スケーリング値(-32000 to 32000) 

Bias バイアス バイアスを％で設定(-320.00 to 320.00) 

Gain ゲイン 倍率を設定(-3.2000 to 3.2000) 

Load ratio 負荷係数設定 ロードセルの負荷係数を設定 

（10.00～100.00） 

Auto Zero オフセット調整 現在の入力値を 0.00%にオフセットします。 

Zero ゼロ点調整 現在の入力値をゼロ点（0.00%）として採用します。 
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Span スパン点調整 現在の入力値をスパン点(100.00%)として採用します。 

負荷係数を設定している場合は、負荷係数の値からス

パン点を算出します。 

Offset Clear オフセット解除 設定しているオフセット値を 0クリアします。 

  ゼロ点調整、スパン点調整を行った後に、オフセット調整を行ってください。 

 

次に「Setting2」のボタンをクリック時の表示画面を示します。 

 

図 4-22．R7G4HML3-6-LC2,LC2A、R7I4DCIE-LC2、R7G4JECT-LC2の初期画面 

 

 

以下の項目の設定が可能です。 

Monitor Output モニタ出力 出力したい値をスケール値で設定します。 

[Auto Scale]ボタンで現入力を設定した値にスケー

リングします。 

[Output]ボタンで設定した値を出力します。 

[Cancel]ボタンでモニタ出力を解除します。 
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Gain adjustment 出力調整 出力を調整します。出力電圧を見ながら希望の出力

になるようにゲイン倍率を確定してください。 

[UP]ボタンでゲイン倍率+0.0001します。 

[DOWN]ボタンでゲイン倍率-0.0001します。 

[APPLY]ボタンでデータを確定します。 

CR Filter CRフィルタ設定 入力の CRフィルタを設定します。 

2kHz、2Hz（LC2/F1の場合は 1Hz、2Hz）が選択

可能です。ボタンをクリックで切り替わります。 

Ext. Voltage 印可電圧設定 センサへの印可電圧を設定します。 

5V、2.5V が選択可能です。ボタンをクリックで切

り替わります。 

Average 移動平均回数設定 入力値の移動平均回数を設定します。 

2、4、8、16、32、64、128、256、512、1024 が

選択可能です。 

[APPLY]ボタンで移動平均回数を採用します。 

  これらの項目は、画面左の I/O->Download では保存されませんのでご注意ください。 

  上記説明の中にある[Auto Scale]ボタン、[APPLY]ボタンで、データは保存されます。 

  また CR Filter、Ext. Voltageはボタンをクリックで、データが保存されます。 

 

【注意】 

R7G4HML3-6-LC2Aでは Ext. Voltageの項目は存在しません。 

R7G4HML3-6-LC2/F1 については、メニューバーの[Model Select]から[LC2/F1]を選択後に、Connect

ボタンで通信可能状態としてください。 
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次に「Setting3」のボタンをクリック時の表示画面を示します。(R7G4JECT-LC2のみ) 

 

図 4-23． R7G4JECT-LC2の初期画面 

以下の項目の設定が可能です。 

Zero Percent Data ゼロ%データ 工場出荷ゼロ／スパン値から書き込んだゼロ% データに

対するユーザゼロ調整値を計算し、設定します。 

ユーザゼロ調整値=((SPAN－ZERO)×ゼロ%データ)÷

10000＋ZERO 

ZERO：工場出荷時のゼロ調整値 

SPAN：工場出荷時のスパン調整値 

Span Percent Data スパン%データ 工場出荷ゼロ／スパン値から書き込んだスパン% データ

のユーザスパン調整値を計算し設定します。 

ロード負荷係数が 100 % 以外の場合は、ロード負荷係数

のユーザスパン値に変換して設定します。 

ユーザスパン調整値＝（（SPAN － ZERO）×スパン% 

データ）÷10000＋ZERO 

ZERO：工場出荷時のゼロ調整値 

SPAN：工場出荷時のスパン調整値 

Offset オフセット 任意のオフセットを設定します。 
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4.5. R7G4HML3-6-STYVS1 の設定項目 

 R7G4HML3-6-STYVS1の設定項目について説明します。 

「4.1.モニタリングするには？」の手順①～③を行い、初期画面を表示します。 

 

次に初期画面を示します。 

 

図 4-24．R7G4HML3-6-STYVS1のスケール設定画面 

 

「Setting1」のボタンで設定内容表示に切り替えることができます。 

以下の入力についての項目の設定が可能です。 

Zero scale ゼロスケーリング 0%スケーリング値を設定(-32000 to 32000) 

Full scale フルスケーリング 100%スケーリング値を設定(-32000 to 32000) 

Bias バイアス バイアスを％で設定(-320.00 to 320.00) 

Gain ゲイン 倍率を設定(-3.2000 to 3.2000) 

Offset 角度オフセット設

定 

現在の角度オフセットを degで表示。 

[Offset]ボタンで現在の入力値を０にオフセット

します。 
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Span 角度スパン設定 角度スパンを degで設定(60.00 to 360.00) 

Rotating direction 入力回転方向設定 入力回転方向を設定。 

「CW」で時計回り、「CCW」で反時計回り。 

Averaging 

Number 

移動平均回数設定 平均回数を設定（１、2、4、8、16、32、64、128、

256） 

 

次に「Setting2」のボタンをクリック時の表示画面を示します。 

 

図 4-25．R7G4HML3-6-STYVS1の初期画面 

以下の項目の設定が可能です。 

Linearization 

point 

折れ線リニアライズ

点数 

折れ線リニアライズ点数を設定(3 to 32)。 

「Disable」でリニアライズ設定が無効。 

Linearization 

table 

折れ線リニアライズ

テーブル 

折れ点を X 軸と Y 軸についてパーセント値の 100 倍

の整数で設定（－1500 to 11500） 

X軸の値は、No.1 ＜ No.2 ＜ No.3 ＜ …となるよう

に設定してください。 

詳細は、本器の取扱説明書を参照ください。 
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次に「Setting3」のボタンをクリック時の表示画面を示します。 

 

図 4-26．R7G4HML3-6-STYVS1の初期画面 

以下の出力についての項目の設定が可能です。 

Zero scale ゼロスケーリング 0%スケーリング値を設定(-32000 to 32000) 

Full scale フルスケーリング 100%スケーリング値を設定(-32000 to 32000) 

Bias バイアス バイアスを％で設定(-320.00 to 320.00) 

Gain ゲイン 倍率を設定(-3.2000 to 3.2000) 

Output 出力端子の有効／

無効の設定 

「Valid」で出力端子が有効、「Invalid」で出

力端子が無効 

Selected Range 出力レンジ設定 出力レンジの設定。 

「-10～+10V」「-5～+5V」「0～10V」「0～5V」

「1～5V」「4～20mA」から選択可能です。 

Output Hold/Clear 通信断時出力設定 通信断時の出力動作を設定。 

「Hold」で通信断時は出力値を保持、「Clear」

で通信断時は出力値を出力リア値に設定。 

Output Clear Value 出力クリア値設定 ％で設定（－15.00 to 115.00） 
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4.6. R7I4DECT-1-PA8Aの設定項目 

 R7I4DECT-1-PA8Aの設定項目について説明します。 

「4.1.モニタリングするには？」の手順①～③を行い、初期画面を表示します。 

 

次に初期画面を示します。 

 

図 4-27．R7I4DECT-1-PA8Aの初期画面 1 

 

「Setting1」のボタンで設定内容表示に切り替えることができます。 

Count 積算パルス数 現在の積算パルス数を表示（0～4294967295） 

Max 最大積算パルス数 積算パルス数の最大値を設定（1～4294967295） 

Count以上の値を設定してください。 

Carry オーバーフロー時の戻り値 オーバーフロー時の戻り値を設定（0または 1） 

Preset プリセット値 現在の積算パルス数に任意の値を設定（Carry～Max） 

テキストボックスに数値を記入後、左の CHｘのボタンを押下

してください。 
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次に「Setting2」のボタンをクリック時の表示画面を示します。 

 

 

図 4-28．R7I4DECT-1-PA8Aの初期画面 2 

以下の項目の設定が可能です。 

Invalid Input 未使用設定 チェック有で該当チャネルの積算パルス数を

常に 0と表示 

Edge 入力パルスカウントエッジ 積算パルスのエッジ方向を設定。 

「立ち下がり(DI-ON)」「立ち上がり(DI-OFF)」

から選択可能。 

Edge of Reset Pulse 外部リセット検出エッジ リセットパルスのエッジ方向を設定。 

「立ち下がり(DI-ON)」「立ち上がり(DI-OFF)」

から選択可能。 

Reset Pulse 外部リセット検出 リセット端子による積算パルス数リセットの

有効無効を設定 

Reset/Preset  

by Master 

上位機器リセット/プリセット 上位マスタからのリセット／プリセットの要

求の有効無効を設定 
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4.7. R7G4FM-DA16，R7K4FM-DA32の設定項目 

R7G4FM-DA16，R7K4FM-DA32の設定項目について説明します。 

「4.1.モニタリングするには？」の手順①～③を行い、初期画面を表示します。 

 

 

図 4-29．R7G4FM-DA16 の初期画面 

 

「CHx to CHx」のボタンで設定 CHを切り替えることができます。 

Count 積算パルス数 現在の積算パルス数を表示（0～4294967295） 

Max 最大積算パルス数 積算パルス数の最大値を設定（1～4294967295） 

Count以上の値を設定してください。 

Carry オーバーフロー時の戻り値 オーバーフロー時の戻り値を設定（0または 1） 

Preset プリセット値 現在の積算パルス数に任意の値を設定（Carry～Max） 

テキストボックスに数値を記入後、左の CHｘのボタンを押下

してください。 
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4.8. 模擬出力するには？ 

R7G4HML-6-YVF4を対象として、模擬出力について説明を行います。 

 

「4.1.モニタリングするには？」の手順①～④を行い、モニタリング画面を表示します。 

 

図 4-30 モニタリング画面 

 

モニタリング中に、図 4-30 モニタリング画面の赤枠内をクリックすると、下図が表示されます。 

 

図 4-31 模擬出力値変更画面 
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図 4-31 模擬出力値変更画面の値を任意に更新し、[Change]ボタンをクリックします。 

⇒クリックされると出力値が反映され、図 4-30 モニタリング画面の Value表示も書き換えられます。 

【注意】 

フィールドバスが有効（上位 PLC等と通信中）の場合、模擬出力は無効となります。 

設定値は、－32000～32000の範囲で設定してください。 

 

模擬出力を終了する場合は、[×]ボタンをクリックします。 

【注意】 

出力値は最終更新値のままとなります。 
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5. 固有機能の設定 

 

 ここでは、各ユニット固有の機能について説明します。 

 各機能の設定・変更後は、R7本体の電源を再投入してください。 

 

5.1. 通信設定ボタン 

 

 R7 シリーズは各種フィールドバスに対応しています。通信プロトコル固有の設定が有る場合、通信設定ボ

タンが表示されます。（図 5-1 通信設定ボタン 画面は Ethernetの場合） 通信設定ボタンをクリックする

ことにより各種プロトコルに対応した設定画面が表示されます。 

 

 

図 5-1 通信設定ボタン 

 

R7 シリーズと通信プロトコルとに対応した表を以下に示します。 

シリーズ名 通信設定ボタン名称 

R7xxxE,R7xxxEIP Ethernet 

R7xxxD DeviceNet® 

R7xxxCIE CC-Link IE Field 

 

 

DeviceNetは、ODVAの登録商標です。 
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5.2. Ethernet通信の設定（R7xxxEシリーズ、R7xxxEIPシリーズ） 

 

    

図 5-2 Ethernet通信(R7xxxE シリーズ（左）、R7xxxEIPシリーズ（右）)の設定 

IP Address 
IPアドレス 

 各テキストボックスにて数値を指定して下さい。 
 0～255の整数 

Subnet Mask 
サブネットマスク 

 各テキストボックスにて数値を指定して下さい。 
 0～255の整数 

Default Gateway 

デフォルトゲートウエイ 

 各テキストボックスにて数値を指定して下さい。 

 ただし、0.0.0.0は設定しないでください。 

 0～255の整数 

MAC Address MACアドレスを表示します。  ― 

TCP Socket 

TCPソケットポート番号（Port1,Port2,Port3,Port4) 

 各テキストボックスにて数値を指定して下さい。 

 0以上の整数 

Modbus/TCP は 502 にしてくださ

い。 
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Linger 
無通信時間を監視し、この設定時間通信がない場合通信

をクローズします。 
0～32767の整数 

TimeOut 
通信をクローズした時から出力保持機能が動作するま

での時間です。 
0～32767の整数 

 

【注意１．】 

設定後は、電源を一旦 OFFし、再度 ONしてください。電源を再投入することにより、設定値が有

効となります。 

【注意２．】 

形式により設定可能な項目が異なります。設定可能な項目のみ表示されます。 
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5.3. DeviceNet通信の設定（R7xxxDシリーズ） 

 

 

図 5-3 DeviceNet通信(R7xxxD シリーズ)の設定 

 

Serial ID 
シリアル番号 

 本体のシリアル番号を表示します。 
設定できません。 

Status 

ステータス付加設定 

 付加する場合は「ON」 付加しない場合は「OFF」 

本体側スイッチで設定します。 

本コンフィギュレータソフトウェア 

からは設定できません。 

TimeOut 
通信をクローズした時から出力保持機能が動作するまでの

時間です。 
0～32767の整数 

 

【注意１．】 

TimeOutは出力機能を持つ機器のみ有効となります。 

入力機能のみの機器では操作しないでください。 
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【注意２．】 

Serial IDは 32bitデータで構成されており、フォーマットは以下となります。 

 

Serial IDのデータフォーマット 

6ビット 6ビット 20ビット 

1桁目 

(0～9A～Z) 

2桁目 

(0～9A～Z) 

3～8桁 

（000000～999999） 

 

Serial IDの 1桁目,2桁目の数値変換表 

文字 数値 

0 0 

1 1 

： ： 

9 9 

A 10 

B 11 

： ： 

Z 35 
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5.4. CC-Link IE Field 通信の設定（R7xxxCIEシリーズ） 

 

 

 

Net Work No. 
ネットワーク番号 

ネットワーク番号を設定します。 
1～239の整数 

Station ID R7xxxCIE本体で設定されている局番が表示されます。 
本コンフィギュレータソフトウェアか

らは設定できません。 

MAC Address MACアドレスを表示します。  ― 

Link Status アップロード時のデータリンク状態を表示します。 

・CYCLIC ：サイクリック通信状態 

・TOKEN-PASS ：トークンパス状態 

・DISCONNECT：通信未確定時 
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5.5. Modbus通信の設定（R7xxxMシリーズ） 

 

 

 

Baud Rate 伝送速度を表示します。 

38400 bps 

19200 bps 

9600 bps 

4800 bps 

Parity パリティビットを表示します。 

ODD (奇数) 

EVEN (偶数) 

NONE (無し) 

Stop Bit ストップビットを表示します。 1 bit / 2 bit 

Word Order 

32bit 積算パルス数のデータ順を表示します。 

 

例：積算パルス数が 999999(0x000F423F)の場合 

   アドレスn, n+1には以下のデータがセットされます。 

設定 n n+1 

Upper(n+1) Lower(n) 0x423F 0x000F 

Lower(n+1) Upper(n+1) 0x000F 0x423F 

  

Upper(n+1)  Lower(n) 

Lower(n+1)  Upper(n+1) 
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6. その他 

 

6.1. 変更履歴 

Ver.0.01.03  …初版 

Ver.0.01.06  …R7G4HML3-6-LC2に対応 

Ver.0.01.07  …R7G4HML-6-SVF4に対応 

Ver.0.01.08  …R7G4HML3-6-YVF4に対応 

Ver.0.01.09  …R7G4HML3-6-LC2Aに対応。取込周期設定を追記。 

Ver.0.01.10  …R7G4HML3-6-PA1の特定の操作で一部設定が反映されない問題を修正 

Ver.0.01.14  …R7G4HML3-6-YSF4に対応 

Ver.0.01.15  …R7G4HML3-6-YSF4の画面表示の誤植を修正 

Ver.0.01.17  …R7G4HML3-6-STYVS1に対応 

Ver.0.01.18  …R7G4HH-A-YVF4、R7G4HH-A-SVF4に対応 

Ver.0.01.19  …R7K4DM-CT32に対応 

Ver.0.01.20  …R7K4FE-6-DC16に対応 

Ver.0.01.21  …R7G4HML3-6-PA1/Aに対応 

Ver.0.01.22  …R7G4FML3-B-DA16に対応 

Ver.0.01.23  …R7G4HEIP-6-DA16, R7G4HEIP-6-DC16に対応 

Ver.0.01.25  …R7I4DECT-1-DAC32C, R7I4DECT-1-SVF8Nに対応 

Ver.0.01.30  …R7I4DECT-1-PA8Aに対応 

Ver.0.01.32  …R7I4DECT-1-DA32A に対応 

Ver.0.01.33  …R7I4DECT-1-SVSF8Nに対応 

Ver.0.01.34  …R7I4DECT-1-DC32A に対応 

Ver.0.01.37  …R7F4HEIP-DA16,R7F4HEIP-DC16,R7F4HEIP-DAC16に対応 

Ver.0.01.39  …R7I4DECT-1-YVF4に対応 

Ver.0.01.40  …R7I4DECT-1-SVSF8N、R7I4DECT-1-SVF8Nのダウンロードの問題を修正 

Ver.0.01.41  …R7F4DD-DA16,R7F4DD-DC16,R7F4DD-DAC16, 

         R7F4HD-DA32,R7F4HD-DC32,R7F4HD-DAC32に対応 

Ver.0.01.44  …R7I4DML3-DA32, R7I4DML3-DC32, R7I4DML3-DAC32に対応 

Ver.0.01.49  …R7I4DCIE-LC2に対応 

Ver.0.01.53  …R7G4FM-DA16，R7K4FM-DA32に対応 

Ver.0.01.56    …誤記修正 

Ver.0.01.57  …R7G4JECT-LC2、R7G4HML3-6-SVAF4に対応 

Ver.0.01.58  …R7F4HEIP-DC32、R7F4HEIP-DA32、R7I4DEIP-DAC32に対応 
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Ver.0.01.59  …R7G4JECT-LC2 機能追加 
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